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Stereo-PA-Verstarker mit DSP

Diese Anleitung richtet sich an den Installateur der Beschal-
lungsanlage mit entsprechenden Fachkenntnissen. Bitte lesen
Sie die Anleitung vor dem Betrieb griindlich durch und heben
Sie sie fur ein spateres Nachlesen auf. Auf Seite 2 finden Sie
alle beschriebenen Bedienelemente und Anschlisse.
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Stereo PA Amplifier with DSP

These instructions are intended for installers of the PA system
with the corresponding technical knowledge. Please read
these instructions carefully prior to operating the amplifier and
keep them for later use. All operating elements and connec-
tions described can be found on page 2.
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Ubersicht der Anschliisse
und Bedienelemente
Status-LEDs
SIG
—-24/-6/0dB gréBter Ausgangspegel
CLIP

Eingangssignal

Ubersteuerung;
langsames Blinken bei
stummgeschalteten Ein-
gangen

Taste ESC zum Abbruch einer Ein-
gabe und zum Verlassen des Einstell-
mends oder eines Untermendis

Taste MENU zum Aufruf des Einstell-
menus und zum Beenden der Eingabe
eines Namens oder Passworts

4 LC-Display

11

12

13

14
15

Drehknopf SELECT/ENTER zum Aus-
wahlen und zum Andern von Einstel-
lungen; zur Bestatigung einer Auswahl
oder Anderung den Knopf driicken

Netzschalter POWER
Halterung fur die Netzsicherung

Eine geschmolzene Sicherung nur
durch eine gleichen Typs ersetzen.

Powercon®-Netzbuchse zum  An-
schluss an eine Steckdose (230 V~/
50 Hz) Uber das beiliegende Netzkabel
Signaleingénge IN-1/IN-2 (XLR)

RJ45-Buchse fiur den Ethernet-An-
schluss zur Konfigurierung des Signal-
prozessors mithilfe eines Computers

USB-Buchse (Typ B) zur Konfigurie-
rung des Signalprozessors mithilfe
eines Computers

Signalausgang OUT-1 mit Line-Pegel
(XLR)

Speakon®-Lautsprecherausgang
BRIDGE fiir den Briickenbetrieb

Speakon-Lautsprecherausgang OUT-3
Speakon-Lautsprecherausgang OUT-2

2 Hinweise fiir den
sicheren Gebrauch
Das Gerat entspricht allen relevanten

Richtlinien der EU und ist deshalb mit C€
gekennzeichnet.

WARNUNG Das Gerat wird mit lebensge-
fahrlicher Netzspannung ver-

A sorgt. Nehmen Sie deshalb
niemals selbst Eingriffe am

Geréat vor und stecken Sie
nichts in die Luftungséffnun-
gen. Es besteht die Gefahr
eines elektrischen Schlages.

® Verwenden Sie das Gerat nur im Innen-
bereich und schitzen Sie es vor Tropf-
und Spritzwasser, hoher Luftfeuchtigkeit
und Hitze (zuldssiger Einsatztemperatur-
bereich 0—40°C).

® Stellen Sie keine mit Flussigkeit gefillten
GefaBe z. B. Trinkglaser, auf das Gerat.

® Die im Geréat entstehende Wéarme muss
durch Luftzirkulation abgegeben werden.
Decken Sie darum die Luftungséffnun-
gen nicht ab.

® Nehmen Sie das Gerat nicht in Betrieb
und ziehen Sie sofort den Netzstecker
aus der Steckdose,

1. wenn sichtbare Schaden am Gerat
oder am Netzkabel vorhanden sind,

2. wenn nach einem Sturz oder Ahnli-
chem der Verdacht auf einen Defekt
besteht,

3. wenn Funktionsstérungen auftreten.

Geben Sie das Gerét in jedem Fall zur

Reparatur in eine Fachwerkstatt.

® Ziehen Sie den Netzstecker nie am Kabel
aus der Steckdose, fassen Sie immer am
Stecker an.

® Wird das Gerat zweckentfremdet, nicht
richtig angeschlossen, falsch bedient oder
nicht fachgerecht repariert, kann keine
Haftung fir daraus resultierende Sach-
oder Personenschaden und keine Garan-
tie fur das Gerat bernommen werden.
Ebenso kann keine Haftung fir durch
Fehlbedienung oder durch einen Defekt
entstandene Datenverluste und deren Fol-
geschaden Gbernommen werden.

Soll das Gerat endgiiltig aus dem
Betrieb genommen werden, Uber-
geben Sie es zur umweltgerechten

mmm Entsorgung einem ortlichen Re-
cyclingbetrieb.

3 Einsatzmoéglichkeiten

Dieser PA-Stereo-Verstarker ist gleicher-
maBen fir Festinstallationen sowie den
mobilen Einsatz, z. B. auf der Bihne und in
der Diskothek konzipiert. Er arbeitet mit
einer Schaltendstufe (Klasse D) und liefert
eine Ausgangsleistung von 2 x 500W an
4 Q) oder im Brickenbetrieb 1 x 1000 W an
8. Zusétzlich zu seinen Lautsprecher-
ausgangen verfugt der Verstarker Uber
einen symmetrischen Line-Pegel-Aus-
gang, der mit dem integrierten Signalpro-
zessor (DSP) z.B. als Tieftonausgang fur
einen Subwoofer konfiguriert werden kann.
Weiterhin stehen mit dem DSP fir jeden
Ein- und Ausgang des Verstérkers zahl-
reiche Signalverarbeitungsmdglichkeiten
durch verschiedene Filterarten, Kompres-
sor, Pegelbegrenzung, Phasenumkehr und
Signalverzégerung zur Verfigung. Da-
durch l&sst sich der Verstarker optimal an
die verwendeten Lautsprecher und die
akustischen Eigenschaften am Einsatzort
anpassen. Alle Einstellungen kdnnen am
Verstarker oder mit einem per USB oder
Ethernet verbundenen Computer editiert
und als Presets im Verstarker gespeichert
werden. Eine Steuerung durch Tabletcom-
puter ist ebenfalls moglich.

Der hohe Wirkungsgrad, die kompakte
Bauform und das geringe Gewicht werden
durch die Ausfihrung als Klasse-D-
Verstérker und den Einsatz eines Schalt-
netzteils erreicht. Umfangreiche Schutz-
schaltungen schitzen den Verstarker und
die angeschlossenen Lautsprecher. Der
temperaturgeregelte Lufter schaltet sich
erst ab 85°C ein, wodurch der Verstarker
bei geringerem Leistungsbedarf gerdusch-
los arbeitet.

4 Aufstellméglichkeiten

Der Verstarker ist fur den Einschub in ein
Rack (482mm/19”) vorgesehen, kann
aber auch als Tischgerat verwendet wer-
den. In jedem Fall muss Luft ungehindert
durch alle Liftungséffnungen strémen kén-
nen, damit eine ausreichende Kihlung
gewabhrleistet ist.

4.1 Rackeinbau

Fur die Rackmontage werden 2 HE bené-
tigt (HE = HOheneinheit = 44,45mm).
Damit das Rack nicht kopflastig wird, muss
der Verstarker im unteren Bereich des
Racks eingeschoben werden. Fir eine
sichere Befestigung reicht die Frontplatte
allein nicht aus. Zusatzlich missen Seiten-
schienen oder eine Bodenplatte das Gerat
halten.

Die vom Verstéarker abgegebene, er-
hitzte Luft muss aus dem Rack austreten
kénnen. Anderenfalls kommt es im Rack zu
einem Hitzestau, wodurch nicht nur der
Verstarker, sondern auch andere Geréate
im Rack beschédigt werden kdnnen. Bei
unzureichendem Warmeabfluss in das
Rack eine Luftereinheit einsetzen.



5 Verstéarker anschlieBen

Vor dem Anschluss bzw. vor dem Veréan-
dern von Anschlissen den Verstarker und
die anzuschlieBenden Gerate ausschalten.

1) Die Signalquelle, z. B. Mischpult oder
Vorverstarker, an die XLR-Eingangs-
buchsen (9) anschlieBen. Die Eingangs-
signale sollten Line-Pegel aufweisen.

2) Die Lautsprecher mit einem zwei- oder
vierpoligen  Speakon-Stecker (z.B.
NL-2... oder NL-4... von NEUTRIK) an
die Speakon-Buchsen anschlieBen:

Fur den 2-Kanal-(Stereo)-Betrieb die
Buchsen OUT-2 (15) und OUT-3 (14)
verwenden. Fur den Mono-Bricken-
betrieb die Buchse BRIDGE (13).
Wichtig: Beachten Sie unbedingt die
erforderlichen Einstellungen fur den
Bruckenbetrieb, = Kap. 9.

Einen Stecker nach dem Einstecken
in die Buchse nach rechts drehen, bis er
einrastet. Zum spateren Herausziehen
den Sicherungsriegel am Stecker zu-
rickziehen und den Stecker nach links
drehen.

Die Tabelle Abb. 3 auf der Seite 2 zeigt
verschiedene Mdglichkeiten mehrere
Lautsprecher an einen Ausgang anzu-
schlieBen und welche Nennbelastbarkeit
(PmIN) jeder Lautsprecher bei entspre-
chender Impedanz (Z) mindestens haben
muss. Beim Zusammenschalten von
mehreren Lautsprechern ist besonders
auf die richtige Polung zu achten und
darauf, dass die Gesamtimpedanz im 2-
Kanal-Betrieb mindestens 4 Q betrégt, im
Briickenbetrieb mindestens 8 Q.

3) Der Line-Ausgang OUT-1 (12) kann
mit dem Line-Pegel-Eingang eines
anderen Gerats (z.B. zusétzlicher Ver-
starker, Aktivlautsprecher, Aufnahme-
geréat) verbunden werden. Die Art des
Signals ist von der Konfiguration des
Signalprozessors abhéngig. So kann
beispielsweise Uber die Mischung der
beiden Eingangssignale und ein Tief-
passfilter ein monofones Ausgangs-
signal flr einen Subwoofer erzeugt wer-
den.

4) Zum Fernsteuern des Verstarkers oder
zum Konfigurieren der Presets den Ver-
stérker Uber die RJ45-Buchse LAN (10)
mit einem einzelnen Computer oder
einem Computernetzwerk verbinden
(r= Kap. 7.2).

Alternativ lasst sich ein Computer
auch Uber die USB-Buchse = (11)
anschlieBen.

5) Zur Stromversorgung den Verstérker
Uber die Netzbuchse (8) mit dem beilie-
genden Netzkabel an eine Steckdose
(230 V~/50 Hz) anschlieBen. Den blau-
en Powercon-Stecker des Netzkabels
nach dem Einstecken in die Netzbuchse
nach rechts drehen, bis er einrastet.
Zum spateren Herausziehen den Siche-
rungsriegel am Stecker zurilickziehen
und den Stecker nach links drehen.

6 Bedienung

VORSICHT: Die Einstellung der Lautstarke
erfolgt digital Gber den Endlosdrehknopf (5)
oder per Fernsteuerung uber ein Netzwerk
oder die USB-Schnittstelle. Daher kann
diese Einstellung vor dem Einschalten des
Gerates weder verandert noch abgelesen
werden. Ist nicht bekannt, mit welcher Ein-
stellung der Verstarker einschaltet, sollten
die Signalquellen zunéchst ausgeschaltet
bleiben.

Den Verstarker mit dem Schalter POWER
(6) einschalten. Das Display (4) zeigt
zundchst Inmitializindg. .., wobei alle
LEDs (1) leuchten. AnschlieBend in der
oberen Zeile den Namen des Verstarkers,
in der unteren Zeile den Namen des aktu-
ellen Presets.

VORSICHT Stellen Sie die Lautstarke nie

sehr hoch ein. Hohe Laut-

A starken kénnen auf Dauer

das Gehor schadigen! Das

Ohr gewdhnt sich an sie und

empfindet sie nach einiger

Zeit als nicht mehr so hoch.

Darum eine hohe Lautstarke

nach der Gewdhnung nicht
weiter erhdhen.

6.1 Zugriffsebenen

Fur die Konfiguration des Gerats stehen
vier Zugriffsebenen mit unterschiedlichen
Rechten zur Verfligung. Der Zugang zu
den Ebenen wird Uber unterschiedliche
Passworter erreicht. Die Passworteingabe
erfolgt am Verstarker (Menupunkt i sss
Lewsls 2 1) oder Uber
das Steuerprogramm (Menupunkt ,Hard-
ware » Enter Password®, 1 Kap. 8.7.1).

Die folgende Tabelle zeigt die Zugriffsebe-
nen in absteigender Rangfolge und die
zugehdrigen Passworter.

Zugriffsebene Passwort*
Development Dev_dsm_
Administrator Adm_dsm_
User monacor
Locked State -

(@) Passwortvorgaben

*Diese Passworter sind vom Werk vorgegeben und
kénnen vom Anwender in der jeweiligen Zugriffs-
ebene oder einer héheren Ebene geédndert wer-
den. — Geanderte Passworter gut merken!

Die Passworter sind im Verstarker gespei-
chert. Nach dem Einschalten ist der Ver-
starker normalerweise in der Ebene ,User”.
Nach der Eingabe eines Passwortes befin-
det sich der Verstarker dann in der ent-
sprechenden Zugriffsebene, bis er ausge-
schaltet wird, ein anderes Passwort einge-
geben wird oder in den ,Locked State”
gewechselt wird. Der ,Locked State“ kann
am Verstarker Uber den MenuUpunkt
Focess Leveld Locked oderim Steu-
erprogramm Uber den Menupunkt ,Hard-
ware # Lock Unit“ erreicht werden.

Es kdénnen in einer hdéheren Ebene
jeweils die Bedienmdglichkeiten der niedri-
geren Ebenen eingeschréankt werden. Dies
ist jedoch nur Uber das Steuerprogramm
maoglich (i Kap. 8.7).

6.2 Betrieb ohne Computer

6.2.1 Preset aufrufen

Hinweis: Die Verfligbarkeit dieser Funktion ist
von den Zugriffsrechten der aktuellen Zugriffs-
ebene abhéangig (1= Kap. 8.7).

1) Die Taste MENU (3) driicken, sodass im
Display (4) Lozcis, dahinter die Spei-
cherplatznummer und darunter der
Name des zuletzt gewéhlten Presets
angezeigt wird.

2) Durch Drehen des Knopfes SELECT/
ENTER (5) das gewunschte Preset aus-
wéhlen und durch Dricken desselben
Knopfes bestatigen. Die folgende Mel-
dung erscheint:

Looasd

3) Zum Laden des gewahlten Presets den
Knopf SELECT/ENTER nach rechts
drehen, sodass die Anzeige wechselt

4) Den Knopf SELECT/ENTER dricken.
Das Preset wird jetzt geladen. Wéhrend
des Ladevorgangs wird hinter dem
Namen des Presets ein # gezeigt.

Bei den beschriebenen Schritten fluhrt das
Dricken der Taste ESC (2) jeweils zum
Abbruch des Vorgangs. Ebenso bricht der
Vorgang ab, wenn langer als eine Minute
keine Taste gedrickt wird.

6.2.2 Systeminformationen anzeigen

Zum Anzeigen von Systeminformationen:
1) Die Taste MENU (3) so oft drlicken, bis
im Display (4) der Begrlff Llg
IF oder

2

. angezeigt wnrd.

2) Durch Drehen des Knopfes SELECT/
ENTER (5) kénnen weitere Informatio-
nen angezeigt werden.

Bei den beschriebenen Schritten fihrt das
Driicken der Taste ESC (2) jeweils zum
Abbruch des Vorgangs. Ebenso bricht der
Vorgang ab, wenn langer als eine Minute
keine Taste gedrickt wird.

6.2.3 Ein- und Ausgangsparameter dndern
Bei ausreichenden Zugriffsrechten der
aktuellen Zugriffsebene und des aktuell
geladenen Presets kdnnen alle Parameter
fur die Ein- und Ausgangskanéle (z. B. Ver-
starkung, Filterparameter, Verzdgerungs-
zeiten, Dynamikbegrenzung) in der Uber-
sichtlichen Darstellung auf dem Computer
durchgefiihrt werden (e Kap. 8). Ist daflr
kein Computer zur Hand, lassen sich die
Einstellungen auch direkt am Verstarker
durchflhren:

Deutsch
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1) Wenn erforderlich, einen vorher aufge-
rufenen Menupunkt mit (mehrmaligem)
Driicken der Taste ESC (2) verlassen,
sodass der Verstdrkername und das
aktuell geladene Preset im Display
angezeigt wird.

2) Den Knopf SELECT/ENTER (5) dri-
cken. Es wird die zuletzt bearbeitete
Ein- oder Ausgang angezeigt, z. B.:

3) Der Pfeil zeigt jeweils auf den Parame-
ter, der durch Drehen des Knopfes
gewahlt werden kann. In diesem Bei-
spiel kann zwischen den Aus- und Ein-
gangen (Out 1/2/3, In 1/2) gewahlt wer-
den. Gekoppelte Eingénge werden z. B.
als Iri 12 angezeigt und kénnen nur
gemeinsam geandert werden.

4) Die Auswahl durch Driicken des Knop-
fes bestatigen.

5) Durch Drehen des Knopfes den ange-
zeigten Wert &ndern.

6) Bei einigen Untermenis kann durch
Driicken des Knopfes auf den nachsten
einzustellenden Parameter umgeschal-
tet werden.

7) Um zurlick in eine héhere Menlebene
zu gelangen oder die Einstellungen zu
beenden, die Taste ESC (wiederholt)
dricken. Wird langer als eine Minute
keine Taste gedrickt, bricht der Einstell-
vorgang automatisch ab.

6.2.4 Preset speichern

Hinweis: Die Verfligbarkeit dieser Funktion ist
von den Zugriffsrechten der aktuellen Zugriffs-
ebene abhangig (1= Kap. 8.7).

Die aktuellen Einstellungen lassen sich fol-
gendermaBen speichern:

1) Die Taste MENU (3) driicken, sodass im
Display (4) , dahinter die Spei-
cherplatznummer und darunter der
Name des dort gespeicherten Presets
angezeigt wird. Bei einem freien Spei-
cherplatz wird Emr%.= angezeigt.

2) Durch Drehen des Knopfes SELECT/
ENTER (5) den gewunschten Speicher-
platz auswéhlen und durch Drucken
desselben Knopfes bestétigen. Die fol-
gende Meldung erscheint:

o

3) Durch Drehen des Knopfes SELECT/
ENTER den ersten Buchstaben flr den
Namen des Presets auswahlen und
durch Drucken desselben Knopfes
bestatigen. Auf die gleiche Art alle wei-
teren Zeichen eingeben, jedoch nach
der Wahl des letzten Zeichens nicht den
Knopf driicken.

4) Nach der Wahl des letzten Zeichens die
Taste MENU drucken. Das Display zeigt
jetzt:

5) Zur Bestatigung den Knopf SELECT/
ENTER dricken. Das Display zeigt
daraufhin kurz:

Die Speicherplatznummer und der Na-
me des gespeicherten Presets werden
jetzt unter dem Geratenamen angezeigt.

Bei den beschriebenen Schritten fihrt das
Dricken der Taste ESC (2) jeweils zum
Abbruch des Vorgangs. Ebenso bricht der
Vorgang ab, wenn langer als eine Minute
keine Taste gedriickt wird.

7 Fernsteuerung uber
einen Computer

Im Verstarker befindet sich ein digitaler
Signalprozessor (DSP), der zum einen die
Aufteilung der Signale auf die Ausgénge
Ubernimmt und zum anderen vielseitige
Maoglichkeiten zur Frequenzgangkorrektur,
Laufzeitkorrektur und zur Dynamikbegren-
zung bietet. Vom Werk aus ist der DSP
bereits mit einer Grundeinstellung ,Factory
Preset” konfiguriert. Fur eigene Einstellun-
gen, z.B. zum Erstellen einer Frequenz-
weiche oder zur Anpassung der Beschal-
lungsanlage an die Raumakustik, dient die
mitgelieferte Computer-Software. Uber die
Ethernetschnittstelle LAN (10) kann der
Verstarker mit einem einzelnen Computer,
einem lokalen Computernetzwerk oder,
z. B. Uiber einen Router, mit gréBeren Com-
puternetzwerken (Internet) verbunden wer-
den. Fir die korrekte Einrichtung der Ver-
bindung sind unbedingt Netzwerktechnik-
Kenntnisse erforderlich.

Hinweis: Bei einer direkten Verbindung des Ver-
starkers mit einem Computer kann die Verwen-
dung eines Crossover-Kabels oder eines entspre-
chenden Adapters erforderlich sein.

Alternativ lasst sich der Verstarker aber
auch, ohne die Einrichtung eines Netzwer-
kes, Uber die USB Schnittstelle ~== (11) mit
einem Computer verbinden.

7.1 Installation der PC-Software
Systemvoraussetzung fur die Installation
des mitgelieferten Steuerprogramms ist ein
Computer mit dem Betriebssystem Wind-
ows XP mit Service Pack 2 oder einer h6he-
ren Windows-Version oder Mac OS X ab
Version 10.5.8 und einer Ethernet-Schnitt-
stelle. Die Bildschirmauflésung sollte min-
destens 1024 x 768 Bildpunkte betragen.
Fur die Installation der PC-Software das
Installationsprogramm ,Setup.exe” oder
LSetup[...] .msi“bzw. [...] Controller.mpkg"“
(fir Mac OS X) auf der mitgelieferten CD
starten und den Anweisungen des Installa-
tionsprogramms folgen.

Wird der Verstarker Uber die USB-
Schnittstelle mit dem Computer verbun-
den, bei der Installation des USB-Treibers
als Quellverzeichnis die mitgelieferte CD
wéhlen.

Windows ist ein registriertes Warenzeichen der Microsoft Corporation
in den USA und anderen Léandern. Mac OS ist ein registriertes Waren-
zeichen von Apple Computer, Inc. in den USA und anderen Léndern.

7.2 Einrichten der
Netzwerkverbindung

Vom Werk ist der Verstarker auf den auto-
matischen Bezug der Netzwerkeinstellun-
gen von einem DHCP-Server in einem
bestehenden Netzwerk voreingestellt.
Existiert in dem angeschlossenen Netz-
werk kein DHCP-Server, wird der Verstar-
ker automatisch selbst zum DHCP-Server
und teilt den anderen Teilnehmern des
Netzwerkes jeweils eine IP-Adresse zu,
wenn diese Teilnehmer auf den automati-
schen Bezug von Netzwerkeinstellungen
eingestellt sind.

Sollen im Netzwerk nur feste IP-Adres-
sen verwendet werden, kann dem Verstér-
ker mit dem Steuerprogramm eine be-
stimmte Adresse zugeteilt werden.

Die aktuelle IP-Adresse des Verstéar-
kers kann Uber das MenU angezeigt wer-
den (1= Kap. 6.2.2).

Hinweis: Damit der Verstérker Uber das Pro-
gramm konfiguriert werden kann, mussen der
Computer und der Verstarker demselben Teilnetz
angehdren. Ist dies nicht der Fall, kann es sinnvoll
sein, den Verstarker zun&chst Uber Ethernet allein
an einen Computer anzuschlieBen, der seine
Netzwerkeinstellungen automatisch vom Verstéar-
ker bezieht. Uber die so erstellte Verbindung ist es
anschlieBend mdglich, die Netzwerkeinstellungen

des Verstarkers dem vorgesehenen Netzwerk
anzupassen.

7.2.1 Hinweis zur Ethernet-Schnittstelle

Die Ethernet-Schnittstelle des Gerats er-
laubt nur eine Ubertragungsrate von max.
10 Megabit/s. Bei Netzwerkgeraten, die nur
100 Megabit/s unterstltzen (z. B. FRITZ!Box
3370), muss deshalb ein 10/100-Switch zwi-
schengeschaltet werden.

7.3 Steuerprogramm

1) Auf dem Computer das Steuerpro-
gramm ,IMG Stage Line DSP Control-
ler* aufrufen.

Es erscheint ein Fenster zur Eingabe
des Passwortes fur den Start des Pro-
gramms. Die Vorgabe ist ,monacor”.
Das Passwort kann aber spéter vom
Anwender geandert werden (== Kap.
7.3.2).

2) Das Passwort eingeben (ohne Anfih-
rungszeichen und unter Beachtung der
Schreibweise).

Bei falsch eingegebenem Passwort
erscheint die Meldung ,Invalid pass-
word!“. In diesem Fall die Meldung
bestatigen und das Passwort erneut ein-
geben.

Das Ubersichtsfenster (Abb. 5) wird ange-
zeigt. Darin erscheint eine Liste aller ver-
bundenen Geréte.

In der oberen Zeile ,All Units* wird in
Klammern angegeben, wieviele Gerate
momentan ,online“ sind, d.h. in aktiver
Verbindung mit dem Computer stehen.
Darunter gibt es fur jedes Gerét eine Zeile
mit verschiedenen Informationen und
Funktionen in den im Folgenden beschrie-
benen Spalten:



% IMG Stage Line DSP Controller,

File  Tools  Help

All Units (3 units online)

IMG DSM-48L AN

x

® IMG DSM-26LAN
g

x

IMG DSM-48L AN

DSP CONTROLLER

(5) Upersichtsfenster

1. Schaltflache ® zum Stummschalten
des Geréts
Wahrend der Stummschaltung ist die
Schaltflache rot. Zum Wiedereinschal-
ten des Tons erneut auf die Schaltflache
klicken. Das Klicken auf die Schaltflache
® in der Zeile ,All Units® fihrt zur gleich-
zeitigen Stummschaltung aller verbun-
denen Gerate.

2. Schaltflache (® zum Identifizieren eines
Geréts
Nach dem Klicken auf die Schaltfla-
che blinkt diese flr einige Sekunden
und mit ihr alle LEDs am Gerat.

3. Symbol @ fiir den Betriebszustand des
Gerats
Es ist im Betrieb des Geréts grin,
im Bereitschaftsmodus (Standby) rot.
Durch Klicken auf das Symbol lasst sich
das Gerat in den anderen Zustand
umschalten. Bei einer unterbrochenen
Verbindung ist das Symbol grau. Wéh-
rend beim Einschalten eines Gerats
eine neue Verbindung aufgebaut wird,
erscheint am Ende der Liste vorUberge-
hend eine zusatzliche Zeile ,Startup...”
mit dem Symbol @.

% IMG Stage Line DSP Controller

File  Tools  Help

B8:06:74:01:22:E3
B8:06:74:01:23:A5
D5:AB:F8:42:D5:FL

169.254.203.11
169.254.138.120
USB port 3

fmy)

5#3’-4 Liwe

. Die beiden senkrechten Balken || stellen

eine einfache Pegelanzeige flr den Ein-
gang und den Ausgang eines Gerats dar.

. Anzeige des Geratenamens

Der voreingestellte Name kann zur
Unterscheidung gleicher Gerate hier
oder im Konfigurationsfenster (1= Kap.
8.2, H) geandert werden.

. Anzeige der Hardware-Adresse (MAC-

Adresse) der Netzwerk- oder USB-
Schnittstelle des Gerats

Uber diese Adresse lasst sich ein
Geréat immer eindeutig identifizieren.

. Anzeige der IP-Adresse eines Uber ein

Netzwerk verbundenen Gerats

Bei Geraten, die Uber USB ange-
schlossen sind, steht hier die Nummer
der USB-Schnittstelle. Bei unterbroche-
ner Verbindung steht an dieser Stelle
,Offline”.

. Schaltflache ® zum Aufruf des Konfigu-

rationsfensters (Abb. 8) fir ein Gerat,
das ,online“ ist

In der Zeile ,All Units“ kann Uber die
Schaltflache © die Liste der Gerate aus-
geblendet oder Uber ¢ wieder einge-
blendet werden.

Group: My_group (2 units)
IMG DSM-26LAN
IMG DSM-48LAN

IMG DSM-26LAN
IMG DSM-48LAN
IMG DSM-48LAN

x

x

®

[ &l Units (3 units online)
x

x

DSP CONTROLLER
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B8:96:74:01:23:A45
05:AB:F8:42:D5:FL
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54.203.11

Enabled
69,2
69.254.138.120

169.254.203.11
169.254.138.120
USB port 3

fmy)
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7.3.1 Gerétegruppen

Mehrere Gerate kénnen zur gemeinsamen
Steuerung in Gruppen zusammengefasst
werden. Sie kénnen so z.B. gemeinsam
stummgeschaltet werden. Welche Para-
meter der gruppierten Gerate gemeinsam
gesteuert werden, lasst sich in den Einstel-
lungen der Gruppe festlegen. Die Zugeho-
rigkeit eines Gerats zu einer Gruppe kann
jederzeit geéndert werden.

7.3.1.1 Neue Gruppe bilden

1) Zum Anlegen einer neuen Gruppe den
MenUpunkt ,Tools » New Group“ aufru-
fen.

2) Im angezeigten Fenster in das Feld
~Enter the name of the new group:* den
gewlinschten Gruppennamen einge-
ben.

In der Liste wird jetzt eine zusétzliche
Zeile fur die Gruppe gezeigt (Zeile
~Group: ...“, 1= Abb. 6).

3) Uber die Schaltfliche @ kann eine
Gruppe eingerichtet oder geandert wer-
den. Es kénnen Geréate zugeflgt oder
entfernt werden und es lassen sich
Gruppenname und Kopplungseigen-
schaften &ndern.

In der Zeile ,Group: ...“ wird jeweils
die aktuelle Anzahl der Gruppenmitglie-
der angezeigt (... units).

4) Uber die Schaltflache ® am Ende der
Zeile ,Group: ...“ kann direkt unter der
Zeile eine Liste aller Gruppenmitglieder
gezeigt oder Uber ) wieder ausgeblen-
det werden.

7.3.1.2 Gruppe léschen

Zum Léschen einer Gruppe in der entspre-
chenden Zeile auf die Schaltflache & Kkli-
cken (1= Abb. 6). Es erscheint eine Sicher-
heitsabfrage zur Bestatigung des Losch-
vorgangs. Wenn der Gruppe zu diesem
Zeitpunkt Gerate zugeordnet sind, er-
scheint eine zusétzliche Sicherheitsab-
frage.

7.3.2 Programmpasswort dndern
Um das Passwort flr den Start des Pro-
gramms zu andern:

1) Den Menlpunkt ,Tools # Change Soft-
ware Password” aufrufen.

2) Im angezeigten Fenster in das Feld
-Enter Old Password:“ das bisherige
Passwort eingeben (vom Werk vorein-
gestellt ist ,monacor®).

3) Im nun angezeigten Fenster in das Feld
LEnter New Password:“ das neue Pass-
wort eingeben.

4) Im anschlieBend angezeigten Fenster in
das Feld ,Confirm New Password:*“ das
neue Passwort zur Bestatigung noch
einmal eingeben und gut merken!
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7.3.3 Demo-Modus

Auch wenn kein Gerat mit dem Computer
verbunden ist, lasst sich zu Demonstrati-
onszwecken ein virtuelles Gerat erzeugen.
Dazu den MenUpunkt ,Tools » Enter Demo
Mode" aufrufen.

In der Liste erscheinen jetzt verschie-
dene virtuelle Gerate mit der zuséatzlichen
Bezeichnung ,DEMO...“. Wie bei realen
Geraten kann hier Gber die Schaltflache ©
das Konfigurationsfenster aufgerufen wer-
den (1= Abb. 8).

Um die virtuellen Gerate wieder aus der
Liste zu entfernen, den Menlpunkt ,Tools
» Leave Demo Mode* aufrufen.

7.3.4 Firmware Update

Fir eine reibungslose Kommunikation zwi-
schen dem Steuerprogramm und einem
Gerat missen beide zueinander passende
Versionen haben. Liegt das Steuerpro-
gramm in einer neueren Version vor, kann
die Firmware (Betriebssystem) der Geréate
Uber das Steuerprogramm aktualisiert wer-
den. Dabei gehen alle in den Geréten
gespeicherten Einstellungen verloren. Sol-
len die Einstellungen erhalten bleiben, mus-
sen sie vor der Aktualisierung auf dem
Computer gesichert werden (1= Kap. 8.11).

Hinweis: Eine Firmware-Aktualisierung geschieht
auf eigenes Risiko. Nach einem Update kann die
Funktionsweise des Gerates von der Beschrei-
bung in der Bedienungsanleitung abweichen.

VORSICHT: Schalten Sie die Signalquel-
len aus oder reduzieren Sie deren Aus-
gangspegel, damit es nach dem Zurlckset-
zen der Einstellungen nicht zu unerwartet
hoher Lautstérke kommt.

Um die Firmware eines Gerats auf den
neuesten Stand zu bringen, den Menu-
punkt ,Tools ®Enable Update* aufrufen.
Hinter den Geraten in der Liste wird jetzt
das Symbol @ angezeigt. Bei einem
grauen Symbol ist kein Update moglich
(z. B. weil die Firmware des Geréats bereits
aktuell ist oder weil die Zugriffsrechte fur
das Update nicht ausreichen).

Hinweis: Bei einem Uber die USB-Schnittstelle
verbundenen Gerat ist ein Update nicht mdglich.
Verbinden Sie das Gerat fir das Update Uber die
Ethernet-Schnittstelle.

Ist das Symbol orange, kann ein Update
erfolgen:

1) In der Zeile des gewinschten Geréts
auf die Schaltflache @ klicken.

2) Es erscheint ein Hinweis, dass das
Gerat wahrend der mehrschrittigen
Aktualisierung nicht ausgeschaltet oder
die Verbindung getrennt werden darf.
Schlagt die Aktualisierung fehl, muss sie
erneut gestartet werden.

Die Aktualisierung mit [OK] starten
oder mit [Cancel] abbrechen.

3) Nach erfolgter Aktualisierung wird eine
weitere Meldung angezeigt. Diese eben-
falls bestatigen.

Um in der Liste die Update-Symbole wie-
der auszublenden, den Menlpunkt ,Tools
» Disable Update” aufrufen.

Hinweis: Bei einem Rucksetzen der Einstellun-
gen auf die Werksvorgaben sind auch die Netz-
werkeinstellungen und die Passworter des Gerats
betroffen, d. h. es kann méglicherweise zunéchst
vom Computer nicht mehr auf das Geréat zugegrif-
fen werden.

Ein Update der Firmware ist ebenfalls Uber
das Men( des Konfigurationsfensters még-
lich (Hardware » Firmware Update), wenn
sich das Gerat in der Zugriffsebene ,Deve-
lopment” befindet.

7.3.5 Programm beenden

Zum Beenden des Programms den Men(-
punkt ,File »Quit“ aufrufen oder das Pro-
grammfenster schlieBen.

8 Verstarker konfigurieren

Achtung!

Der Signalprozessor ist in Verbindung mit
dem Steuerprogramm ein effektives Werk-
zeug, mit dem sehr feine, aber auch gra-
vierende Anderungen der Ubertragungsei-
genschaften der Beschallungsanlage még-
lich sind.

Jede Anderung der Parameter sollte
deshalb mit Bedacht und Sachverstand
vorgenommen werden. Extreme Anderun-
gen der Einstellungen kénnen schlimms-
tenfalls zur Schadigung der Lautsprecher
fihren.

Zur Konfiguration des Verstérkers in der
Liste bei dem Gerat auf die Schaltflache &
klicken (e Abb. 5, 6).

Das Konfigurationsfenster (Abb. 8) mit
der Hauptansicht (MAIN) wird flr das
gewahlte Gerat angezeigt. Auf der linken
Seite wird als Farbfeld neben LINK E der
Verbindungsstatus des Verstarkers ange-
zeigt. Bei grinem Feld besteht eine Daten-
verbindung. Bei rotem Feld ist die Verbin-
dung unterbrochen, das Andern einer Ein-
stellung ist dann nicht moglich. Bei einem
Versuch erscheint eine entsprechende Mel-
dung.

Auf dem Bildschirm geénderte Einstel-
lungen werden bei bestehender Verbin-
dung sofort zum Verstarker Ubertragen.
Die Einstellungen kénnen auf dem Compu-
ter und im Verstarker (== Kap. 8.2) als Pre-
set gespeichert werden. Zudem kann fest-
gelegt werden, ob beim Einschalten des
Verstarkers immer ein bestimmtes Preset
geladen werden soll oder der letzte Zu-
stand vor dem Ausschalten (i Kap. 8.10).

Uber die Schaltflachen der linken Sei-
tenleiste kann auf die anderen Ansichten
(X-OVER, IN 1/2, OUT 1/2/3) umgeschal-
tet werden (Abb. 9—11), wenn die Zugriffs-
rechte des aktuellen Presets dies zulassen
(== Kap. 8.7.3). Uber die Schaltflache
MAIN gelangt man zurlick zur Hauptan-
sicht.

8.1 Signalweg

In der Abbildung 7 ist der Signalweg durch
den Verstarker als Blockdiagramm darge-
stellt. Von den beiden Eingédngen durchlau-
fen die Signale nach der Analog-Digital-
Umwandlung den Eingangsverstarker
(GAIN), ein Hochpass- und Tiefpassfilter
(HPF+LPF), die 10-Band-Klangeinstellung
(PEQ), die Signalverzégerung (DELAY),
einen Dynamikkompressor (COMPRES-
SOR) und die Pegelbegrenzung (LIMI-
TER). Fir jeden der drei Ausgangskanéle
kann ein eigenes Mischsignal aus den bei-
den bearbeiteten Eingangssignalen er-
zeugt werden. Dieses hat die gleichen
Bearbeitungsmdglichkeiten wie die Signale
der Eingangskanale mit der zusétzlichen
Méoglichkeit der Phasenumkehr (PHASE
INVERT) und wird dann der Digital-Analog-
Umwandlung zugefuhrt. Die Ausgangska-
nale OUT 2 und OUT 3 werden dann uber
die Klasse-D-Endstufen an die Lautspre-
cherausgange weiterfuhrt. Der Ausgangs-
kanal OUT 1 fuhrt auf den Line-Pegel-
Ausgang ,OUT-1%

Die Parameter zu den gezeigten BI6-
cken kénnen in den Ansichten MAIN, X-
OVER, IN 1/2 und OUT 1/2/3 eingestellt
werden. Fur einige ist der Zugriff von meh-
reren Ansichten mdglich.

Hinweis: Die Einstellmdglichkeiten sind von den
Zugriffsrechten der aktuellen Zugriffsebene ab-
hangig (== Kap. 6.1). Um alle Einstellungen
durchfiihren zu koénnen, sollte beim ersten Aufruf
des Steuerprogramms in die Zugriffsebene ,De-
velopment” gewechselt werden. Von hier aus kon-
nen dann, entsprechend dem fur die Bedienung
des Gerats geplanten Personenkreis, die Zugriffs-
rechte und Passwérter fur die anderen Zugriffs-
ebenen festgelegt werden (1= Kap. 8.7).



i MUTE
IN 1 ioTo
A out out
w2 - Ho - oH = HL-H- Fo
i GAN HPF+LPF PEQ1-10 DELAY COMPRESSOR LIMITER i
i MUTE 5
IN 2 fo7T o i
A out out
wo— 7L - Ho-oH = HL-H- e
i GAN HPF+LPF PEQ1-10 DELAY COMPRESSOR LIMITER
........................................................... o/o
LINK
MUTE
OuUT 1 o o
: out out
Ny, D LINE LEVEL OUTPUT
— N O = [: _[f - / - > “OUT-1”
% - in in VA A
MIXER GAIN HPF+LPF PEQ1-10 DELAY COMPRESSOR LIMITER ~ PHASE
------------------- INVERT
i MUTE
OUT 2 S T o T SPEAKER OUTPUTS
E : out out
: Ay, D
: — <O O = [ —/— —D « ,
{EH-HooHeHE-HEHZHZ
MIXER | GAN HPF+LPF PEQ1-10 DELAY COMPRESSOR LIMITER ~ PHASE CLASSD
: INVERT :
i MUTE i
OuT 3 i o7 o :
i * out out :
A7 | D D
_— _— vor _— b | _— —-—u— _—
% AN H = Hee A A e 14 “OUT-3"
MIXER GAIN HPF+LPF PEQ1-10 DELAY COMPRESSOR LIMITER ~ PHASE | CLASSD
INVERT
______________________________________________________________ O/o____________________________________________________________:
LINK
“BRIDGE”
@ Blockdiagramm

8.2 Ansicht MAIN (Abb. 8)

H Schaltflaichen zum Umschalten der An-
sicht

LOCAL PRESETS
Speichern ,Store” der aktuellen Einstel-
lungen als Presets auf dem Computer
(wie Menupunkt ,File »Save“) und
Laden ,Load" vom Computer (wie Meni-
punkt ,File » Open®)

=2 STA-1000DSP {05:AB:F7:55:E0:DL) (Administrator)

Hardware  Help

HE UNIT PRESETS

Speichern ,Store“ der aktuellen Einstel-
lungen als Presets im Verstarker und
Laden ,Load“ eines im Verstarker
gespeicherten Presets

Den Speicherplatz im Listenfeld wéhlen
und im oberen Feld einen Namen einge-
ben.

5P CONTROLUER]

LOCAL PRESETS

Load

MAIN

UNIT PRESETS E
L&R + Sub

12: L&R + Sub

Load

L R TNy EEC [ RRY (L E

STA-1000DSP (05:AB:Fi v

UNIT NAME E
STA-1000D5P ot

Status

LINK ®

Details>>

L@
| 7.4 | 7.44 ] [ -20.00 [ -15.04 | -15.04 |
[io]mure— @ e 2 e ®
mi. Jr sub ML R |

Temperature

Ansicht MAIN

B LINK — Verbindungsstatus
Grln = verbunden
Rot = nicht verbunden
Fir den Wechsel zu einem anderen
Gerat, dieses im Listenfeld wahlen.

H UNIT NAME — Name des Geréts; kann
durch Uberschreiben gedndert werden

B GAIN-Regler zur Lautstéarkeeinstellung
fur die beiden Eingadnge, daneben
Pegel-Anzeigen, darunter Eingabe-/
Anzeigefelder fir den Verstarkungswert

GAIN-Regler zur Lautstérkeeinstellung
fur die drei Ausgénge, daneben Pegel-
Anzeigen, darunter Eingabe-/Anzeige-
felder fur den Verstarkungswert

B LINK-Schalter zur Kopplung der beiden
Eingénge

Bl LINK-Schalter zur Kopplung der Aus-
gange 2und 3

M MUTE-Schalter zum Stummschalten
des jeweiligen Ein- oder Ausgangs

i Eingabefelder zur Benennung der Ein-
und Ausgéange
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8.3 Ansicht IN 1/2 (Abb. 9)

[ Schaltflichen zum Umschalten der An-
sicht

B Kurvendarstellung des Amplituden-Fre-
quenzgangs
Zu jedem der 10 parametrischen Filter
gehdrt ein Bezugspunkt (kleines Qua-
drat mit der Filternummer) und eine Fre-
quenzkurve in einer eigenen Farbe. Der
resultierende Frequenzgang aller akiti-
ven Filter ist als weiBe Kurve dargestellt.

Die Filterparameter kénnen zum Teil
auch grafisch eingestellt werden. Dazu
mit der Maus den jeweiligen Bezugs-
punkt verschieben:

— Anderung der Frequenz durch hori-
zontales Verschieben

— Anderung der Verstarkung durch verti-
kales Verschieben

— Anderung der Filtergiite/Bandbreite
durch horizontales Verschieben mit
der rechten Maustaste

— Ein- oder Ausschalten eines Filters
durch Doppelklick auf den Bezugs-
punkt

Ein-/Ausblenden der Werte aller
aktiven Filter

qQ, Feineinstellmodus ein-/ausschalten

& vergréBerte Darstellung = Vollbild-
darstellung; Ruckkehr zur kleinen
Darstellung mit %

B Kurven als Bilddatei (PNG) spei-
chern

@ GAIN-Regler zur Lautstérkeeinstellung
fur den entsprechenden Eingang, dane-
ben Pegel-Anzeige, darunter Eingabe-/
Anzeigefeld fur den Verstérkungswert
(gleiche Wirkung wie B)

@ Schalter ON jeweils zum Aktivieren/
Deaktivieren eines Filters

8.4 Ansicht OUT 1/2/3 (Abb. 10)

B Schaltflichen zum Umschalten der An-
sicht

Hl Regler MIXER zum Einstellen des
Mischsignals aus den beiden Eingangs-
kanalen fur diesen Ausgang, daneben
Pegel-Anzeigen, darunter Eingabe-/
Anzeigefelder fir den Verstarkungswert

Bl Kurvendarstellung des Amplituden-Fre-
quenzgangs
(Beschreibung 1= Kap. 8.3, [H)

B GAIN-Regler zur Lautstirkeeinstellung
fir den entsprechenden Ausgang,
daneben Pegel-Anzeige, darunter Ein-
gabe-/Anzeigefeld fir den Verstéar-
kungswert (gleiche Wirkung wie H)

B8 Schalter ON jeweils zum Aktivieren/
Deaktivieren eines Filters

TA-1000DSP (05:AB:F7:55:E0:DL) (Administrator)
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4.76kHz

10.2 kHz
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(9) Ansicht IN 1

M Listenfeld TYPE zur Auswahl des Filter-
typs

Eingabe-/Anzeigefeld FREQ fir die Fil-
terfrequenz (Werte in Hz eingeben)

B Eingabe-/Anzeigefeld Q/BW fiir die Fil-
tergute/Bandbreite (Umschalten durch
Klicken auf Q oder BW)

B Eingabe-/Anzeigefeld GAIN fir die
Pegelanhebung/-absenkung des Filters

Hl Hochpassfilter HPF: Eingabe-/Anzeige-
feld fur die Grenzfrequenz (Werte in Hz
eingeben, ,Off* < 20 Hz)

Bl Hochpassfilter HPF: Listenfeld fur die
Auswahl des Filtertyps

A Tiefpassfilter LPF: Eingabe-/Anzeigefeld
fur die Grenzfrequenz (Werte in Hz ein-
geben, ,Off* > 20 kHz)

8 Tiefpassfilter LPF: Listenfeld fur die
Auswahl des Filtertyps

3 STA-1000DSP (05:AB:F7:55: E0:DL) (Administrator)
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Bl MUTE-Schalter zum Stummschalten
des entsprechenden Eingangs (gleiche
Wirkung wie )

B8 Schaltfliche COMPRESSOR zum Auf-
rufen des Konfigurationsfenster fir den
Kompressor des entsprechenden Ein-
gangs (1= Kap. 8.6)

H3 Drehregler DELAY mit Eingabe-/Anzei-
gefeld fur die Einstellung der Signalver-
zbgerung des entsprechenden Ein-
gangs; im Listenfeld darunter die Einheit
wahlen: Zeit oder Entfernung (zur auto-
matischen Berechnung der Schalllauf-
zeit)

Pegelbegrenzung LIMITER: Drehregler
THR mit Eingabe-/Anzeigefeld fir den
Schwellwert (threshold)

H Pegelbegrenzung LIMITER: Drehregler
REL mit Eingabe-/Anzeigefeld fur die
Ruckstellzeit (release time)
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B Listenfeld TYPE zur Auswahl des Filter-
typs

EH Eingabe-/Anzeigefeld FREQ fir die Fil-
terfrequenz (Werte in Hz eingeben)

H Eingabe-/Anzeigefeld Q/BW fiir die Fil-
terglte/Bandbreite (Umschalten durch
Klicken auf Q oder BW)

Eingabe-/Anzeigefeld GAIN fur die
Pegelanhebung/-absenkung des Filters

Hochpassfilter HPF: Eingabe-/Anzeige-
feld fur die Grenzfrequenz (Werte in Hz
eingeben, ,Off < 20 Hz)

B Hochpassfilter HPF: Listenfeld fur die
Auswahl des Filtertyps

M Tiefpassfilter LPF: Eingabe-/Anzeigefeld
fur die Grenzfrequenz (Werte in Hz ein-
geben, ,Off* > 20 kHz)

Bl Tiefpassfilter LPF: Listenfeld fir die
Auswahl des Filtertyps

B MUTE-Schalter zum Stummschalten
des entsprechenden Ausgangs (gleiche
Wirkung wie M)

Schalter INVERT fiir die Phasenumkehr

M@ Schaltfliche COMPRESSOR zum Auf-
rufen des Konfigurationsfenster fir den
Kompressor des entsprechenden Aus-
gangs (1= Kap. 8.6)

[H Drehregler DELAY mit Eingabe-/Anzei-
gefeld fur die Einstellung der Signalver-
zbgerung des entsprechenden Aus-
gangs; im Listenfeld darunter die Einheit
wéhlen: Zeit oder Entfernung (zur auto-
matischen Berechnung der Schalllauf-
zeit)

M Pegelbegrenzung LIMITER: Drehregler
THR mit Eingabe-/Anzeigefeld fir den
Schwellwert (threshold)

Pegelbegrenzung LIMITER: Drehregler
REL mit Eingabe-/Anzeigefeld flr die
Ruckstellzeit (release time)

% STA-1000DSP {05:4B:F7:55:F0:DL) (Administrator)

File  Hardware Help

CROSSOVER

8.5 Ansicht X-OVER (Abb. 11)

[ Schaltflachen zum Umschalten der An-
sicht

[ Kurvendarstellung des Amplituden-Fre-
quenzgangs fur alle Hoch- und Tief-
passfilter
Durch die Darstellung aller drei Aus-
gange in einem Diagramm werden bei
der Erstellung einer Frequenzweiche
die Frequenzlbergange deutlich. (Bei
einer Kopplung der Ausgénge 2 und 3
werden nur zwei Filterkurven angezeigt.)

Die Grenzfrequenzen der Filter wer-
den durch dreieckige Marken oberhalb
der Kurve dargestellt. Durch Verschie-
ben einer Marke mit der Maus lasst sich
die Frequenz andern (alternativ zur
numerischen Eingabe in Bl/B).

Bl Hochpassfilter HPF: Eingabe-/Anzeige-
feld fur die Grenzfrequenz (Werte in Hz
eingeben, ,Off < 20 Hz)

(gleiche Wirkung wie E)

Hl Hochpassfilter HPF: Listenfeld fir die
Auswahl des Filtertyps (gleiche Wirkung
wie E)

B Tiefpassfilter LPF: Eingabe-/Anzeigefeld
fur die Grenzfrequenz (Werte in Hz ein-
geben, ,Off“ > 20 kHz)

(gleiche Wirkung wie i)

B Tiefpassfilter LPF: Listenfeld fir die
Auswahl des Filtertyps (gleiche Wirkung
wie [l)

B Eingabe-/Anzeigefeld G (gain) fur die
Einstellung der Lautstarke des Aus-
gangs (gleiche Wirkung wie H und )

H Eingabe-/Anzeigefeld D (delay) fir die
Einstellung der Signalverzégerung des
Ausgangs (gleiche Wirkung wie [H)

Pegelanzeigen fir die Ausgénge

Schalter LINK zur Kopplung der Aus-
génge 2 und 3 (gleiche Wirkung wie El)

@ &

MUTE

D OO B8

PHASE INVERT

ele & [5

0.0ms

(D) Ansicht X-OVER

D a mn- Moz

Bl MUTE-Schalter zum Stummschalten
des jeweiligen Ausgangs (gleiche Wir-
kung wie )

Bl Schalter PHASE INVERT fir die Pha-
senumkehr des jeweiligen Ausgangs
(gleiche Wirkung wie [H)

8.6 Fenster COMPRESSOR

= STA-1000DSP (05:48:F... [= |[B][X]

File  Hardwate Help

COMPRESSOR

Preset

Threshold

24dBu

Release

Ratio .

Makeup Gain

(12) Kompressorkonfigurationsfenster

[ Schaltflache BACK flihrt zurlick zur vor-
herigen Ansicht

B Pegelanzeige VU und Verstarkungsmin-
derung GR (gain reduction)

& Drehregler Threshold mit Eingabe-/
Anzeigefeld fir den Schwellwert

@ Drehregler Attack mit Eingabe-/Anzei-
gefeld flr die Ansprechzeit

[ Drehregler Hold mit Eingabe-/Anzeige-
feld fur die Haltezeit

[ Drehregler Release mit Eingabe-/Anzei-
gefeld fur die Ruckstellzeit

[ Drehregler Ratio mit Eingabe-/Anzeige-
feld fiir das Kompressionsverhaltnis

Drehregler Makeup Gain mit Eingabe-/

Anzeigefeld far den Pegelverlustaus-
gleich

Deutsch
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8.7 Zugriffsrechte verwalten

8.7.1 Passworter eingeben

Nach dem Einschalten des Geréts ist nor-
malerweise die Zugriffsebene ,User“ ge-
wahlt (i Kap. 6.1). Um in eine hdhere
Zugriffsebene zu gelangen, das entspre-
chende Passwort Uber den MenUpunkt
,Hardware » Enter Password“ eingeben.

8.7.2 Passworter dndern

Zum Andern des Passwortes der aktuellen
Zugriffsebene oder, in der Ebene ,Deve-
lopment*, zum Andern der Passwérter fiir
eine niedrigere Zugriffsebene den Menu-
punkt ,Hardware B Configure »Change
Password“ bzw. ,Hardware #»Passwords
» User/Admin/Developer Password" aufru-
fen.

Fir das Passwort der aktuellen Ebene
ist es erforderlich, zuné&chst das bisherige
Passwort einzugeben, dann das neue, wel-
ches dann noch einmal zur Bestétigung
eingegeben werden muss. Passworter fir
niedrigere Zugriffsebenen kénnen dage-
gen direkt eingegeben werden und werden
auch angezeigt.

In der Ebene ,Development® ist es
zudem moglich, einzelne Presets mit
gesonderten Passwortern zu versehen.
Vor dem Speichern eines Presets missen
dafir die gewtinschten Einstellungen tber
das MenU ,Preset »Passwords »Admin
Password“ und ,,... » Developer Password*
vorgenommen werden.

Wichtig: Mit dem Preset gespeicherte
Passworter haben Vorrang vor den System-
passwortern. Wird ein Preset aufgerufen,
das mit individuellen Passwortern fur die
Zugriffsebenen ,Administrator und ,Deve-
lopment” gespeichert wurde, sind die Sys-
tempassworter fur diese Ebenen ungultig.

8.7.3 Zugriffsrechte d&ndern

Uber den Meniizweig ,Hardware » Confi-
gure # Access Rights” kdnnen die Zugriffs-
rechte fir die niedrigeren Zugriffsebenen
festgelegt werden. Die Tabelle (Abb. 13)
zeigt die Mdglichkeiten und Voreinstellun-
gen fir die einzelnen Ebenen.

Eine Besonderheit stellt der Zugriff auf
die Einstellungen der Ein- und Ausgangs-
parameter dar. Die Zugriffsrechte hierfur
(Access Input/Output Channel) werden
ausschlieBlich in der Ebene ,Development®
mit dem jeweiligen Preset gespeichert. Vor
dem Speichern eines Presets missen
dafir die gewlinschten Einstellungen Uber
das jeweilige Menl ,Preset »Access
Rights # Locked Access Rights®, ,,... # User
Access Rights und ,... » Admin Access
Rights“ vorgenommen werden.

8.8 Locked State

Um in die unterste Zugriffsebene ,Locked
State” zu gelangen, den Meniipunkt ,Hard-
ware BLock Unit“ aufrufen. Eine Meldung
wird angezeigt, die darauf hinweist, dass
diese Ebene nur Uber die Eingabe eines
korrekten Passworts einer hdheren Ebene
wieder verlassen werden kann. Die Mel-
dung mit OK bestétigen.

8.9 Standby

Um das Gerat in den Bereitschaftsmodus
L~Standby” zu versetzen, den MenUpunkt
s~Hardware » Go to Standby*“ aufrufen. Fur
die Ruckkehr zum normalen Betrieb dann
den Menipunkt ,Hardware » Exit Standby*
aufrufen (vgl. Kap. 7.3).

8.10 Einschalt-Preset festlegen

Um festzulegen, mit welchen Einstellungen
das Gerat einschalten soll, den MenUpunkt
.Hardware » Configure » Power On Preset”
aufrufen.

Im Listenfeld des angezeigten Fensters
das Preset wéhlen, das jedes Mal nach
dem Einschalten des Geréats automatisch
geladen werden soll oder die Option ,Last
Setting“, damit das Gerat nach dem Ein-
schalten immer die letzten vor dem Aus-
schalten durchgefuhrten Einstellungen be-
halt.

8.11 Sichern/Zuriickladen
aller Presets

Zum Sichern aller Presets des Gerats auf
dem Computer den Meniupunkt ,File
» Backup Presets aufrufen und den Spei-
cherort (Ordner) wahlen.

Zum spateren Zurlickladen der gesi-
cherten Presets den MenuUpunkt ,File
» Restore Presets” aufrufen.

Zugriffsrechte

Zugriffsebenen

Access Rights

Development Administrator

User Locked State

Load Presets

v o4}

| O

Save Presets

v o4}

] O

Load Factory File

v

Create Factory File

AN

Enable Front Panel Access

Enable Display Lock Control

NN

Change User Access Rights

Change Locked Access Rights

Change Unit Name

AN NN

O

Lock Automatically After Power Cycle

Change Unit Configuration
(Network, AutoStandby, Startup Preset)

Load an Empty Preset

Upgrade the Unit Firmware

Access Input Channel

Access Output Channel

HIR|FO ® OFHRRE

NYANENENERN

OxO0o O OxrM

Oojojoo] o

(13) Mégliche Zugriffsrechte und deren Voreinstellungen



9 Mono-Briickenbetrieb
Der Briickenbetrieb dient dazu, an einem
Lautsprecher eine gréBere Leistung zu
erhalten. Dazu werden beide Leistungsver-
starker zu einem Monoverstarker kombi-
niert: Dasselbe Eingangssignal wird auf den
einen Leistungsverstérker und, mit invertier-
ter Phase, auf den anderen geleitet.
Dadurch verdoppelt sich die Spannung am
Ausgang, wenn der Lautsprecher an der
Buchse BRIDGE (13) angeschlossen ist.
Im Gegensatz zu anderen Verstarker-
modellen verfligt der STA-1000DSP nicht
Uber einen Schalter zur Wahl der Betriebs-
art ,Bridge®, diese lasst sich aber einfach
Uber den Signalprozessor konfigurieren:

1) Ausgange OUT 2 und OUT 3 koppeln:
In der Ansicht ,MAIN“ den LINK-Schal-
ter B einschalten (Ring leuchtet) oder in
der Ansicht ,X-OVER® BEl. Damit (ber-
nimmt der Ausgang OUT 3 alle Einstel-
lungen von OUT 2.

2) Die Kopplung der Ausgange OUT 2 und
OUT 3 wieder ausschalten, damit sich
der Ausgang OUT 3 einzeln invertieren
lasst. In der Ansicht ,OUT 3“ den
INVERT-Schalter [ einschalten (Ring
leuchtet) oder in der Ansicht ,X-OVER"
den entsprechenden Schalter PHASE
INVERT HI fur OUT 3.

3) Sicherstellen, dass die Ausgange OUT 2

und OUT 3 ein identisches Signal erhal-
ten:
In den Ansichten OUT 2 und OUT 3 im
Bereich MIXER Hl identische Einstellun-
gen vornehmen. (Die Mischung der Ein-
gangssignale wurde nicht durch die
Kopplung der Ausgéange gleichgeschal-
tet.) Dabei kann das Signal eines einzel-
nen Eingangskanals oder ein Mischsig-
nal beider Eingangskanéle gewahlt wer-
den.

4) Die Einstellungen als PRESET im Gerat
speichern (1= Kap. 8.2, Hl) und dabei
einen Namen verwenden, der auf den
Brickenbetrieb hinweist. So kann im
Display des Verstarkers sofort erkannt
werden, dass dieser sich im Mono-Bri-
ckenbetrieb befindet.

Die beschriebenen Einstellungen lassen
sich, ausreichende Zugriffsrechte voraus-
gesetzt, auch Uber das Display am Verstér-
ker durchfuhren.

Hinweis: In den héheren Zugriffsebenen ist im
Steuerprogramm ein Meniipunkt zur Wahl der
Betriebsart ,Stereo” oder ,Bridge Mono* vorhan-
den (Hardware # Configure » Output Mode #» Out-
puts 2 and 3 »...). Im Gegensatz zu der oben
beschriebenen Einstellung des Briickenbetriebs
lasst sich der lber diesen Menupunkt gewéhlte
Brlckenbetrieb aber weder am Verstérker noch in
den Ansichten des Steuerprogramms erkennen.
Deshalb sollte Gber diesen Menupunkt immer die
Option ,Stereo” eingestellt bleiben und ein Bri-
ckenbetrieb nach der vorherigen Beschreibung
vorgenommen werden.

10 Steuerung uber einen
Tabletcomputer

Zusatzlich zum mitgelieferten Steuerpro-
gramm fir einen PC ist auch ein Steuerpro-
gramm fir Tabletcomputer unter der
Bezeichnung ,DSP-CONTROL® im ,App
Store” des Computerherstellers Apple Inc.
erhéltlich.

11 Technische Daten
Sinus-Ausgangsleistung
an4Q: ... ... 2 x 500 W
an8Q: ............... 2 x280W
Briickenbetrieb an 8 Q: .. 1000 W

Spitzenausgangsleistung: . 1200 W

Frequenzbereich: .. ...... 20-20000Hz
Klirrfaktor: ............. <0,05%
Kanaltrennung

bei Nennleistungan 8Q: .>100dB
Stérabstand: ........... > 119dB (A-bewertet)

Nenneingangsspannung: . . 1,2V
Max. Eingangsspannung: . 11V

Eingangsimpedanz: . .. ... 24kQ

Line-Ausgang: .......... 3,5 V/1 kQ, symmetrisch
Stromversorgung: .. ..... 230 V~/50 Hz
Leistungsaufnahme: ... .. max. 1160 VA
Einsatztemperatur: . ... ... 0-40°C

Abmessungen: .......... 482 x 89 x 335 mm, 2 HE
Gewicht: . .............. 5,85kg

Anderungen vorbehalten.

Diese Bedienungsanleitung ist urheberrechtlich fir MONACOR® INTERNATIONAL GmbH & Co. KG geschiitzt.
Eine Reproduktion fiir eigene kommerzielle Zwecke — auch auszugsweise — ist untersagt.

Deutsch

13



English

14

11

12

13

14
15

Connections and
Control Elements

Status LEDs

SIG input signal
—24/-6/0dB highest output level
CLIP overload;
will flash slowly for muted
inputs

Button ESC to cancel an entry and to
exit the setting menu or a submenu
Button MENU to call up the setting
menu and to terminate the entry of a
name or password

LC display

Rotary knob SELECT/ENTER to se-
lect and change settings; to confirm a
selection or modification, press the
knob

POWER switch

Support for the mains fuse

Always replace a blown fuse by one of
the same type.

Powercon® mains jack for connection
to a socket (230V~/50Hz) via the
mains cable provided

Signal inputs IN-1/IN-2 (XLR)

RJ45 jack for the Ethernet connection
to configure the signal processor by
means of a computer

USB jack (type B) to configure the sig-
nal processor by means of a computer
Signal output OUT-1 with line level
(XLR)

Speakon® speaker output

BRIDGE for the bridged mode
Speakon speaker output OUT-3

Speakon speaker output OUT-2

2 Safety Notes

The unit corresponds to all relevant direc-
tives of the EU and is therefore marked
with C€.

WARNING The unit uses dangerous

mains voltage. Leave servi-
A cing to skilled personnel only
and do not insert anything
into the air vents. Inexpert
handling of the unit may

result in electric shock.
® The unit is suitable for indoor use only.
Protect it against dripping water and
splash water, high air humidity and heat
(admissible ambient temperature range:
0-40°C).

® Do not place any vessel filled with liquid
on the unit, e. g. a drinking glass.

® The heat generated inside the unit must
be dissipated by air circulation; never
cover the air vents of the housing.

® Do not operate the unit and immediately
disconnect the mains plug from the
socket

1. if the unit or the mains cable is visibly
damaged,

2. if a defect might have occurred after
the unit was dropped or suffered a
similar accident,

3. if malfunctions occur.

In any case the unit must be repaired by

skilled personnel.

® Never pull the mains cable to disconnect
the mains plug from the socket; always
seize the plug.

® No guarantee claims for the unit and no
liability for any resulting personal dam-
age or material damage will be accepted
if the unit is used for other purposes than
originally intended, if it is not correctly
connected or operated or if it is not
repaired in an expert way. Likewise, no
liability will be accepted for data loss
caused by a defect or operating errors
and for any consequential damage of this
data loss.

B

If the unit is to be put out of opera-
tion definitively, take it to a local
recycling plant for a disposal which
is not harmful to the environment.

3 Applications
This PA stereo amplifier is equally
designed for fixed installations and for
mobile applications, e. g. on stage or in dis-
cotheques. It operates with a power ampli-
fier (class D) and provides an output power
of 2 x 500 W at 4 Q or, in the bridged mode,
of 1 x 1000W at 8Q. In addition to its
speaker outputs, the amplifier features a
balanced line level output; with the inte-
grated signal processor (DSP), this output
can, for example, be configured as a bass
frequency output for a subwoofer. Addition-
ally, the DSP provides numerous signal
processing options such as various filter
types, compressor, level limitation, phase
inversion and signal delay for each input
and output. Thus, the amplifier can be ide-
ally adapted to the speakers used and to
the acoustic situation of the application
site. All settings can be edited at the ampli-
fier or with a computer connected via USB
or Ethernet and can be saved as presets in
the amplifier. It is also possible to control
the amplifier with a tablet computer.
Designed as a class D amplifier and
using a switch-mode power supply, the
amplifier offers a high level of efficiency in
a low-weight compact housing. Extensive
protective circuits protect the amplifier and
the speakers connected. The temperature-
controlled fan will switch on when the tem-
perature rises above 85 °C; thus, the ampli-
fier will work silently when the power
requirements are low.

4 Setup Options

The amplifier is designed for installation
into a rack for units of a width of 482mm
(19”) but can also be used as a tabletop
unit. In order to ensure sufficient cooling of
the amplifier, air must always be able to
flow freely through all air vents.

4.1 Rack installation

For rack installation, the amplifier requires
2RS (RS = rack space = 44.45mm). To
prevent the rack from becoming top-heavy,
insert the amplifier into the lower section of
the rack. The front plate is not sufficient for
fixing the amplifier safely; additionally use
lateral rails or a bottom plate to secure the
amplifier.

The hot air given off by the amplifier
must be dissipated from the rack; other-
wise heat will accumulate in the rack which
may not only damage the amplifier but also
other units in the rack. In case of insuffi-
cient heat dissipation, install a ventilation
unit into the rack.



5 Connecting the Amplifier

Prior to making or changing any connec-
tions, switch off the amplifier and the units
to be connected.

1) Connect the signal source, e.g. mixer
or preamplifier, to the XLR input jacks (9).
The input signals should have line levels.

2) Connect the speakers with a two-pole
or four-pole Speakon plug (e.g. NL-2...
or NL-4... from NEUTRIK) to the
Speakon jacks:

For the 2-channel (stereo) mode, use
the jacks OUT-2 (15) and OUT-3 (14).
For the mono bridged mode, use the
jack BRIDGE (13).

Important: Make absolutely sure to
observe the settings required for the
bridged mode, 1 chapter 9.

Insert a plug into the jack and turn it
clockwise until it engages. To remove
the plug, pull back the latch on the plug
and turn the plug counter-clockwise.

The table (fig. 3) on page 2 shows vari-
ous options of how to connect multiple
speakers to a single output and the min-
imum rated power (PmIN) each speaker
requires at the according impedance (Z).
When connecting multiple speakers,
always observe the correct polarity and
make sure that the total impedance is at
least 4Q (2-channel mode) or 8Q
(bridged mode).

3) The line output OUT-1 (12) can be con-
nected to the line level input of a differ-
ent unit (e. g. additional amplifier, active
speaker, recorder). The signal type de-
pends on the configuration of the signal
processor. It is, for example, possible to
mix the two input signals and to use a
low pass filter to create a monophonic
output signal for a subwoofer.

4) To operate the amplifier by remote con-
trol or to configure the preset, connect
the amplifier to a single computer or a
computer network via the RJ45 jack
LAN (10) [ chapter 7.2].

Alternatively, connect the computer
via the USB jack = (11).

5) For power supply, connect the mains
jack (8) of the amplifier to a socket
(230 V~/50 Hz), using the mains cable
supplied. Insert the blue Powercon plug
of the mains cable into the mains jack
and turn the plug clockwise until it
engages. To remove the plug, pull back
the latch on the plug and turn the plug
counter-clockwise.

6 Operation

CAUTION: The volume is digitally adjusted
by means of the rotary knob (5) or by
remote control via a network or via the USB
interface; it cannot be changed or read
before the unit is switched on. Therefore,
the signal sources should be switched off
for the time being when the initial adjust-
ment of the amplifier at switch-on is not
known.

Switch on the amplifier with the POWER
switch (6). Initially, Imitizlizind...
will appear on the display (4), and all LEDs
(1) will light up. Then the upper line will
show the name of the amplifier and the
lower line will show the name of the current
preset.

CAUTION Never adjust the amplifier to a
very high volume. Permanent

A high volumes may damage your
hearing! Your ear will get accus-

tomed to high volumes which

do not seem to be that high af-

ter some time. Therefore, do not

further increase a high volume
after getting used to it.

6.1 Access levels
Four access levels with different rights are
available for configuring the amplifier. The
levels are accessed by different pass-
words. The passwords are entered at the
ampllfler (menu item
Errte =woti) or via the control pro-
gram (menu item “Hardware » Enter Pass-
word”, 1=° chapter 8.7.1).

The following table shows the access
levels in descending order and the corre-
sponding passwords.

Access level Password*
Development Dev_dsm_
Administrator Adm_dsm_
User monacor
Locked State -

@ Factory-set passwords

*These passwords are factory-set; the user can
change these passwords in the respective
access level or in a higher access level. — Make
sure to remember the changed passwords!

The passwords are saved in the amplifier.
When the amplifier is switched on, it will
usually be in the access level “User”. When
a password is entered, the amplifier will be
in the corresponding access level until it is
switched off, a different password is
entered or the access level “Locked State”
is called up. To go to the access level

“Locked State”, either use the menu item
He = Lewsl: Lockedatthe ampllfler
or the menu item “Hardware # Lock Unit” o
the control program.

The operating options of a level can be
restricted in a higher level. These restric-
tions, however, can only be made in the
control program (s chapter 8.7).

6.2 Operation without a computer

6.2.1 Calling up a preset

Note: The availability of this function depends
on the access rights of the current access level
(= chapter 8.7).

1) Press the button MENU (3) so that
will appear on the display (4),
foIIowed by the storage location num-
ber; the name of the preset most
recently selected will appear on the sec-
ond line.

2) Turn the knob SELECT/ENTER (5) to
select the preset desired, then press the
knob to confirm. The following message
will appear:

3) To load the preset selected, turn the
knob SELECT/ENTER clockwise so that
the foIIowmg message will appear:

4) Press the knob SELECT/ENTER. The
preset will be loaded. During the load
process, the name of the preset will be
followed by a :

Pressing the button ESC (2) in the steps
described above will cancel the procedure.
The procedure will also be cancelled after
one minute when no button is pressed.

6.2.2 Showing system information
To show system information:
1) Press the button MENU (3) repeatedly
until L. - Tefe i, IF Aodddress or
= appears on the display (4).

2) To show additional information, turn the
knob SELECT/ENTER (5).

Pressing the button ESC (2) in the steps
described above will cancel the procedure.
The procedure will also be cancelled after
one minute when no button is pressed.
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6.2.3 Changing input parameters and
output parameters

If allowed by the access rights of the cur-
rent access level and the currently loaded
preset, all parameters for the input chan-
nels and output channels (e.g. gain, filter
parameters, delay times, dynamic range
limitation) can be changed by means of the
well-arranged computer views (s chap-
ter 8). If no computer is available, the
changes can be directly made at the ampli-
fier:

1) If required, (repeatedly) press the button
ESC (2) to exit a menu item previously
called up so that the name of the ampli-
fier and the name of the currently loaded
preset are shown on the display.

2) Press the knob SELECT/ENTER (5).
The input or output most recently edited
will be shown, e. g.:

3) The arrow points to the parameter that
can be selected by turning the knob.
In this example, it is possible to select

between the outputs and inputs
(Out 1/2/3, In 1/2). Linked inputs are
shown as 12, for example, and can

only be jointly changed.
4) Press the knob to confirm the selection.

5) Turn the knob to change the value
shown.

6) In some submenus, the knob can be
pressed to go to the next parameter to
be set.

7) To go back to a higher menu level or to
exit the settings, press the button ESC
(repeatedly). The setting procedure will
also be automatically cancelled after
one minute when no button is pressed.

6.2.4 Saving a preset

Note: The availability of this function depends on
the access rights of the current access level
(1= chapter 8.7).

To save the current settings:

)Press the button MENU (3) so that
=% will appear on the display (4),
followed by the storage location num-
ber; the name of the preset saved at the
storage location will appear on the sec-
ond line. If the storage location is not
used, & t..+ will be shown.

2) Turn the knob SELECT/ENTER (5) to
select the storage location desired, then
press the knob to confirm. The following
message will appear:

e

3) Turn the knob SELECT/ENTER to
select the first character for the name of
the preset, then press the knob to con-
firm. Proceed in the same way to enter
the other characters of the name; how-
ever, do not press the knob after select-
ing the final character.

4) After selecting the final character, press
the button MENU. The following mes-
sage will appear on the display:

e

5) Press the knob SELECT/ENTER to con-
firm. The following message will briefly
appear on the display:

Ok

The storage location number and the
name of the saved preset will be shown
beneath the unit name.

Pressing the button ESC (2) in the steps
described above will cancel the procedure.
The procedure will also be cancelled after
one minute when no button is pressed.

7 Remote Control via
a Computer

The amplifier includes a digital signal
processor (DSP) which on the one hand
splits the signals to the outputs and on the
other hand offers a wide range of options
for equalizing the frequency response,
readjusting the delay time, and limiting the
dynamic range. The DSP is factory-config-
ured to the basic setting “Factory Preset”.
The computer software delivered with the
amplifier allows users to define their own
settings, e. g. for creating a crossover net-
work or for adapting the system to the room
acoustics. By means of the Ethernet inter-
face LAN (10), the amplifier can be con-
nected to a single computer, a local com-
puter network or, e. g. via a router, to larger
computer networks (Internet). Network
technology expertise is indispensable for
the correct connection setup.

Note: A direct connection of the amplifier to a

computer may require the use of a crossover
cable or a corresponding adapter.

As an alternative (without setting up a net-
work), the amplifier can be connected to a
computer via the USB interface = (11).

7.1 Installing the PC software

To install the control program supplied, a
computer with the operating system Win-
dows XP with Service Pack 2 or with a later
Windows version or with Mac OS Xversion
10.5.8 or later and an Ethernet interface is
required. The screen resolution should be
at least 1024 x 768 pixels. To install the PC
software, start the installation program
“Setup.exe” or “Setup [...].msi” or (for Mac
OS X) “[...] Controller.mpkg” on the CD
supplied and then follow the instructions of
the installation program.

If the amplifier is connected to the com-
puter via the USB interface, select the CD
supplied as the source directory when
installing the USB driver.

Windows is a registered trademark of Microsoft Corporation in the
United States and other countries. Mac OS is a registered trademark
of Apple Computer, Inc. in the United States and other countries.

7.2 Setting up the
network connection

The amplifier is factory-set to automatically
adopt the network settings of a DHCP
server in an existing network. If there is no
DHCP server on the network connected,
the amplifier will assume the function of a
DHCP server and will assign IP addresses
to the other network members, provided
that they have been set to automatically
adopt network settings.

If only fixed IP addresses are to be
used on the network, a specific address
can be assigned to the amplifier by means
of the control program.

The current IP address of the ampli-
fier can be shown via the menu (== chap-
ter 6.2.2).

Note: The amplifier can only be configured by
means of the program if the computer and the
amplifier belong to the same subnet. If not, it may
be reasonable to first only connect, via Ethernet,
the amplifier to a computer that automatically
adopts the network settings from the ampilifier.
With this connection, the network settings of the
amplifier can then be adapted to the network to be
used.

7.2.1 Note concerning the Ethernet interface
The Ethernet interface of the unit only
supports a bit rate of up to 10 megabit/s.
Therefore, a 10/100 switch must be in-
serted for network units that only support
100 megabit/s (e. g. FRITZ!Box 3370).

7.3 Control program

1) At the computer, call up the control pro-
gram “IMG Stage Line DSP Controller”.

A password-entry window will appear

for starting the program. The factory-set
password is “monacor” which, however,
can later be changed by the user
(== chapter 7.3.2).

2) Enter the password (without quota-
tion marks and observing the correct
spelling).

If the password is not correctly en-
tered, the message “Invalid password!”
will appear. In this case, confirm the
message and enter the password again.

The overview window (fig. 5) will appear,
displaying a list of all units connected.

In the upper row “All Units”, the text in
parenthesis specifies the number of units
that are currently “online”, i.e. that are
actively connected to the computer. The
rows below the upper row contain the fol-
lowing columns with various information
and functions for the individual units:
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File  Tools

Help

All Units (3 units online)
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IMG DSM-48L AN

B8:06:74:01:22:E3
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IMG DSM-48L AN

DSP CONTROLLER

@ Overview window

1. Button ® to mute the unit
The button will be red when the unit is
muted. To unmute the sound, click the
button again. To mute all units con-
nected at the same time, click the button
® in the row “All Units”.

2. Button (® to identify a unit
When this button is clicked, the button
and all LEDs at the unit will flash for a
few seconds.

3. Symbol © for the operating mode of the
unit
When the unit is in operation, the
symbol will be green; when the unit is in
the standby mode, the symbol will be
red. Click the symbol to change the
mode of the unit. The symbol will be
grey when the connection is interrupted.
When a unit is switched on and a new
connection is being established, an
additional row (“Startup ...”) with the
symbol @ will temporarily appear at the
end of the list.

% IMG Stage Line DSP Controller

File  Tools  Help

USB port 3

fmy)

5#3’-4 Liwe

. The two vertical bars || are simple level

indicators for the input and the output of
the unit.

. Indication of the unit name

For easier distinction of the same
units, the predefined name can be
changed here or in the configuration
window (s> chapter 8.2, H).

. Indication of the hardware address

(MAC address) of the network interface
or USB interface of the unit

With this address, a unit can always
be clearly identified.

. Indication of the IP address of a unit

connected via a network

For units connected via USB, the
number of the USB interface will be indi-
cated. When the connection is inter-
rupted, “Offline” will be shown here.

. Button ® to call up the configuration

window (fig. 8) for a unit that is “online”

To hide the list of units, click the but-
ton ® in the row “All units”. To show the
list again, click the button ®.

Group: My_group (2 units)
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7.3.1 Unit groups

Multiple units may be grouped so that they
can be jointly controlled (e. g. jointly muted).
The group settings allow the definition of
the parameters that are to be jointly con-
trolled. It is always possible to add units to
the group or remove units from the group.

7.3.1.1 Creating a new group
1) To create a new group, call up the menu
item “Tools » New Group”.

2) A new window will be displayed. In the
field “Enter the name of the new group:”,
enter the group name desired.

A new row for the group will be added
to the list (row “Group: ...”, 1= fig. 6).

3) To create or change a group, use the
button @. It is possible to add or remove
units, and the group name and the link-
age characteristics can be changed.

The row “Group: ...” indicates the cur-
rent number of group members (... units).

4) Use the button ® at the end of the row
“Group ...” to show a list of all group
members directly beneath the row
“Group ...”. To hide the list again, click
the button ®.

7.3.1.2 Deleting a group

To delete a group, click the button & in the
corresponding row (1= fig. 6). A confirma-
tion box will appear, asking you to confirm
the deletion. If units are currently contained
in the group, another confirmation box will
appear.

7.3.2 Changing the program password
To change the password for starting the
program:

1) Call up the menu item “Tools » Change
Software Password”.

2) A new window will be displayed. In the
field “Enter Old Password:”, enter the
current password (the factory-set pass-
word is “monacor”).

3) A new window will be displayed. In the
field “Enter New Password:”, enter the
new password.

4) A new window will be displayed. In the
field “Confirm New Password:”, enter
the new password again to confirm it.
Make sure to remember the password!
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7.3.3 Demo mode

Even when no unit is connected to the com-
puter, it is possible to create a virtual unit
for demonstration purposes. To do so, call
up the menu item “Tools »Enter Demo
Mode”.

Various virtual units with the additional
designation “DEMO...” will be added to the
list. As for real units, the button ¢ can be
used to call up the configuration window
(r=r fig. 8).

To remove the virtual units from the list,
call up the menu item “Tools » Leave Demo
Mode”.

7.3.4 Firmware update

The control program and the unit must be
equipped with matching firmware versions
to ensure smooth communication. If the
version of the control program is newer, the
firmware (operating system) of the units
may be updated via the control program.
With this update, all settings saved on the
units will be lost. To keep the settings, save
them on the computer (1= chapter 8.11)
before starting the update.

Note: Firmware updates are performed at your
own risk. After the update, the functions of the unit
may differ from those described in the instruction
manual.

CAUTION: Switch off the signal sources or
reduce their output level to avoid an unex-
pectedly high volume after the settings
have been reset.

To update the firmware of a unit, call up the
menu item “Tools » Enable Update”. In the
list, the symbol @ will appear after the
units. Units with a grey symbol cannot be
updated (e.g. because the units are
already equipped with the current firmware
version or because the access rights do not
allow for an update).

Note: Units connected via the USB interface can-
not be updated. To update these units, connect
them via the Ethernet interface.

Units with an orange symbol can be up-
dated:

1) Click the button &) in the row of the cor-
responding unit.

2) A message will appear which informs
you that it is not allowed to switch off the
unit or to interrupt the connection during
the multi-step update process. If the
update fails, it must be started again.

Click [OK] to start the update, or click
[Cancel] to cancel it.

3) Upon completion of the update, another
message will appear. Confirm this mes-
sage.

To hide the update symbols in the list
again, call up the menu item “Tools # Dis-
able Update”.

Note: Resetting to the factory settings will also
affect the network settings and the passwords of

the unit, i.e. it may initially not be possible to
access the unit via the computer.

When the unit is in the access level “Devel-
opment”, the firmware may also be up-
dated via the menu of the configuration
window (Hardware » Firmware Update).

7.3.5 Exiting the program

To exit the program, call up the menu item
“File » Quit” or close the program window.

8 Configuring the Amplifier

Attention!

Combined with the control program, the
signal processor is an effective tool for
making very detailed but also major
changes to the transmission properties of
the PA system.

Therefore, each modification to the
parameters should be performed with
care and expertise. At the worst, extreme
changes to the settings may damage the
speakers.

To configure the ampilifier, click the button
® (s= figs. 5, 6) in the appropriate row of
the list.

The configuration window (fig. 8) with
the view MAIN for the unit selected will
appear. The colour field on the left-hand
side, next to LINK B, will indicate the con-
nection status of the unit. When the colour
field is green, a data connection has been
established. A red field will indicate that the
connection has been interrupted and that it
is not possible to modify settings. If the user
tries to make changes, an error message
will appear.

Any settings changed on the screen will
be instantly transferred to the amplifier pro-
vided that a data connection exists. The
settings can be saved as presets on the
computer and in the amplifier (1= chap-
ter 8.2). In addition, it will be possible to
define if the amplifier, when being switched
on, is to load a specific preset or the state it
was in when switched off (1s° chapter 8.10).

If allowed by the access rights of the
current preset (i chapter 8.7.3.), the
buttons on the left side bar can be used to
go to the other views (X-OVER, IN 1/2,
OUT 1/2/3) [figs. 9—11]. To return to the
main view, click the button MAIN.

8.1 Signal path

Figure 7 shows a block diagram of the path
a signal takes through the amplifier. Start-
ing at the inputs, the signals, after analog/
digital conversion, pass the input amplifier
(GAIN), a high pass filter (HPF), a low pass
filter (LPF), the 10-band sound adjustment
(PEQ), the signal delay (DELAY), a dy-
namic range compressor (COMPRES-
SOR) and the level limiter (LIMITER). For
each of the three output channels, an indi-
vidual mixed signal can be created from the
two input signals processed. The mixed
signal will have the same processing op-
tions as the signals of the input channels
and additionally the phase inversion option
(PHASE INVERT); after processing, the
mixed signal will be routed to digital/analog
conversion. The output channels OUT 2
and OUT 3 will be routed to the speaker
outputs via the class D power amplifiers.
The output channel OUT 1 will lead to the
line level output “OUT-1".

The parameters of the blocks shown
can be set in the views MAIN, X-OVER,
IN 1/2 and OUT 1/2/3. Some of the pa-
rameters can be accessed via several
views.

Note: The setting options available depend on the
access rights of the current access level (1= chap-
ter 6.1). To be able to make all settings, go to the
access level “Development” when calling up the
control program for the first time. This level allows
you to define the access rights and passwords for

the other access levels as required by the users
who will operate the unit (i chapter 8.7).
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Bl Switch LINK to link the outputs 2 and 3

@ Switches MUTE to mute the correspon-
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8.3 View IN 1/2 (fig. 9)
B Buttons to go to a different view

B Curve diagram of the magnitude fre-
qguency response
Each of the 10 parametric filters has a
point of reference (small square with fil-
ter number) and a frequency curve in a
specific colour. The frequency response
resulting from all active filters is repre-
sented by a white curve.

Some of the filter parameters can also
be set graphically. To do so, move the
corresponding point of reference with
the mouse:

—move horizontally to change the fre-
quency

— move vertically to change the gain

— move horizontally with the right mouse
button to change the quality factor/
bandwidth

— double-click a point of reference to
switch the corresponding filter on or off

to show/hide the values of all active
filters

Q, to switch the fine-adjustment mode
on and off

% to enlarge the display = full-screen
mode; ® to return to the reduced-
size mode

K to save curves as image files (PNG)

@ Control GAIN to adjust the volume of the
corresponding input; the level indicator
is next to the control; the input/indication
field for the gain value is beneath the
control (same effect as @)

H Switches ON to activate/deactivate the
corresponding filter

A List field TYPE to select the filter type

8.4 View OUT 1/2/3 (fig. 10)
E Buttons to go to a different view

Hl Controls MIXER to adjust the mixed sig-
nal from the two input channels for this
output; the level indicators are next to
the controls; the input/indication fields
for the gain value are beneath the con-
trols

Bl Curve diagram of the magnitude fre-
quency response
(description 1= chapter 8.3, [H)

B Control GAIN to adjust the volume of the
corresponding output; the level indicator
is next to the control; the input/indication
field for the gain value is beneath the
control (same effect as H)

B Switches ON to activate/deactivate the
corresponding filter
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Input/Indication field FREQ for the filter
frequency (enter values in Hz)

[\ Input/Indication field Q/BW for the qual-
ity factor/bandwidth (click Q or BW to
change between quality factor and band-
width)

B Input/Indication field GAIN for filter boost/
attenuation

El High pass filter HPF: input/indication field
for the cut-off frequency (enter values in
Hz, “Off’ < 20 Hz)

Bl High pass filter HPF: list field to select
the filter type

B8 Low pass filter LPF: input/indication field
for the cut-off frequency (enter values in
Hz, “Off" > 20 kHz)

B Low pass filter LPF: list field to select the
filter type
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E Switch MUTE to mute the correspond-
ing input (same effect as M)

B Button COMPRESSOR to call up the
configuration window for the compres-
sor of the corresponding input (e chap-
ter 8.6)

H Rotary knob DELAY with input/indica-
tion field for adjusting the signal delay of
the corresponding input; select the
measuring unit from the list field: time or
distance (for automatic calculation of the
sound delay time)

Level LIMITER: rotary knob THR with
input/indication field for the threshold
value

i Level LIMITER: rotary knob REL with
input/ndication field for the release time
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Bl List field TYPE to select the filter type

B8 Input/Indication field FREQ for the filter
frequency (enter values in Hz)

H3 Input/Indication field Q/BW for the qual-
ity factor/bandwidth (click Q or BW to
change between quality factor and band-
width)

B Input/Indication field GAIN for filter
boost/attenuation

Bl High pass filter HPF: input/indication
field for the cut-off frequency (enter val-
ues in Hz, “Off” < 20 Hz)

B High pass filter HPF: list field to select
the filter type

M Low pass filter LPF: input/indication field
for the cut-off frequency (enter values in
Hz, “Off” > 20 kHz)

B Low pass filter LPF: list field to select the
filter type

M Switch MUTE to mute the correspond-
ing output (same effect as M)

Switch INVERT for phase inversion

M Button COMPRESSOR to call up the
configuration window for the compres-
sor of the corresponding output
(i chapter 8.6)

[H Rotary knob DELAY with input/indica-
tion field for adjusting the signal delay of
the corresponding output; select the
measuring unit from the list field: time or
distance (for automatic calculation of the
sound delay time)

M Level LIMITER: rotary knob THR with
input/indication field for the threshold
value

Level LIMITER: rotary knob REL with
input/indication field for the release time

% STA-1000DSP {05:4B:F7:55:F0:DL) (Administrator)

File  Hardware Help

CROSSOVER

8.5 View X-OVER (fig. 11)
[H Buttons to go to a different view

[ Curve diagram of the magnitude fre-
quency response for all high pass filters
and all low pass filters
When a crossover network is created, all
three outputs are represented in a dia-
gram so that the frequency crossovers
are easy to identify. (When the outputs 2
and 3 are linked, only two filter curves
are shown.)

The cut-off frequencies of the filters
are represented by triangular markings
above the curve. To change the fre-
quency, move the corresponding mark-
ing with the mouse (as an alternative to
the numeric input in B1/E).

Bl High pass filter HPF: input/indication
field for the cut-off frequency (enter val-
ues in Hz; “Off’ < 20 Hz)

(same effect as )

Bl High pass filter HPF: list field to select
the filter type (same effect as Hl)

B Low pass filter LPF: input/indication field
for the cut-off frequency (enter values
in Hz, “Off” > 20 kHz) [same effect as [J]

B Low pass filter LPF: list field to select the
filter type (same effect as M)

Bl Input/Indication field G (gain) for adjust-
ing the volume of the output (same effect
as H and B)

B Input/indication field D (delay) for ad-
justing the signal delay of the output
(same effect as [H)

Hl Level indicators for the outputs

Switch LINK to link the outputs 2 and 3
(same effect as )

@ &

MUTE

D OO B8

PHASE INVERT

ele & [5

0.0ms

(D) View X-OVER

D a mn- Moz

B Switch MUTE to mute the correspond-
ing output (same effect as M)

Bl Switch PHASE INVERT for phase inver-
sion of the corresponding output (same
effect as [)

8.6 Window COMPRESSOR

= ST4-1000DSP (05:48:F... [2 |[B]X]

Eile  Hardware Help

COMPRESSOR

Preset

Threshold .

Attack

ooms

-
Makeup Gain

@ Compressor configuration window

[ Button BACK to return to the previous
view
@ Level indicator VU and gain reduction GR

& Rotary knob “Threshold” with input/indi-
cation field for the threshold value

@ Rotary knob “Attack” with input/indica-
tion field for the attack time

& Rotary knob “Hold” with input/indication
field for the hold time

[ Rotary knob “Release” with input/indica-
tion field for the release time

[ Rotary knob “Ratio” with input/indication
field for the compression ratio

Rotary knob “Makeup Gain” with input/
indication field for level loss compensa-
tion
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8.7 Managing access rights

8.7.1 Entering passwords

When the unit is switched on, the access
level “User” will usually be selected
(r=” chapter 6.1). To go to a higher access
level, call up the menu item “Hardware
» Enter Password” and enter the password.

8.7.2 Changing passwords

To change the password in the current
access level, or, in the level “Develop-
ment”, to change the passwords for a lower
access level, call up the menu item “Hard-
ware BConfigure BChange Password”
or “Hardware »Passwords »User/Admin/
Developer Password”.

To change the password of the current
level, first enter the current password, then
enter the new password, and finally re-
enter the new password to confirm it. Pass-
words for lower access levels can be
directly entered and will also be displayed.

In the level “Development”, individual
presets can be saved with separate pass-
words. Prior to saving a preset, make
the desired settings via the menus “Pre-
set # Passwords » Admin Password” and
“... #Developer Password”.

Important: Passwords saved with the pre-
set will take precedence over system pass-
words. When a preset is called up which
has been saved with individual passwords
for the access levels “Administrator” and
“Development”, the system passwords for
these levels will be invalid.

8.7.3 Changing access rights

Via the menu branch “Hardware » Config-
ure # Access Rights”, the access rights for
lower access levels can be defined. The
table (fig. 13) shows the options and fac-
tory-set values for the individual levels.

Particular rules apply concerning the
access to the settings of the input parame-
ters and output parameters. The access
rights for these settings (Access Input/Out-
put Channel) are exclusively saved on the
level “Development” (together with the cor-
responding preset). Prior to saving a pre-
set, make the settings desired via the cor-
responding menu “Preset # Access Rights
»Locked Access Rights”, “... #User
Access Rights” and “... # Admin Access
Rights”.

8.8 Locked State

Call up the menu item “Hardware »Lock
Unit” to go to the lowest access level
“Locked State”. A message will appear to
inform you that you can exit this level
only by entering the valid password of a
higher level. Click “OK” to confirm this mes-
sage.

8.9 Standby

Call up the menu item “Hardware » Go to
Standby” to set the unit to the standby
mode. To return to the normal mode, call up
the menu item “Hardware #»Exit Standby”
(see chapter 7.3).

8.10 Defining the switch-on preset
Call up the menu item “Hardware » Config-
ure #Power On Preset” to define the set-
tings that shall apply when the unit is
switched on.

In the list field of the window displayed,
select the preset that is to be automatically
loaded each time the unit is switched on, or
select the option “Last Setting” if the unit is
to use the settings most recently made
before the unit was switched off.

8.11 Saving/Restoring all presets
Call up the menu item “File » Backup Pre-
sets” to save all presets of the unit on the
computer, then select the storage location
(folder).

To restore the saved presets, call up
the menu item “File » Restore Presets”.
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Load Factory File

v

Create Factory File

AN

Enable Front Panel Access

Enable Display Lock Control

NN

Change User Access Rights

Change Locked Access Rights

Change Unit Name

AN NN

O

Lock Automatically After Power Cycle

Change Unit Configuration
(Network, AutoStandby, Startup Preset)

Load an Empty Preset

Upgrade the Unit Firmware

Access Input Channel

Access Output Channel

HIR|FO ® OFHRRE

NYANENENERN

OxO0o O OxrM

Oojojoo] o

(13) Available access rights and their factory-set values



9 Mono Bridged Mode

The bridged mode is used to obtain more
power at a single speaker. For this, the two
power amplifiers are combined to a mono
amplifier: The same input signal is routed
to the two power amplifiers (one with phase
inversion, the other without phase inver-
sion). This will double the voltage at the
output when the speaker is connected to
the jack BRIDGE (13).

Unlike other amplifier models, the
amplifier STA-1000DSP does not provide a
switch for selecting the operating mode
“Bridge”; this, however, can be easily con-
figured via the signal processor:

1) Link the outputs OUT 2 and OUT 3:
Switch on the switch LINK in the view
“MAIN” B or in the view “X-OVER” HI;
the ring will light up. Thus, the output
OUT 3 will adopt all settings of the out-
put OUT 2.

2) Deactivate the linkage between the out-
puts OUT 2 and OUT 3 again so that the
output OUT 3 can be separately in-
verted. Switch on the switch INVERT [H
in the view “OUT 3” or the corresponding
switch PHASE INVERT B for OUT 3 in
the view “X-OVER?”; the ring will light up.

3) Make sure that the outputs OUT 2 and
OUT 8 receive the same signal:
Make identical settings in the section
MIXER HJ of the views OUT 2 and
OUT 3. (Linkage of the outputs has not
synchronised mixing of input signals.)
The signal of a single input channel or a
mixed signal of both input channels can
be selected.

4) Save the settings as a PRESET in the
unit (i= chapter 8.2, H), using a name
that makes reference to the bridged
mode. Thus, it will be possible to
instantly tell by the display of the ampli-
fier that the amplifier is in the mono
bridged mode.

If allowed by the access rights available,
the settings described can also be made
via the display of the amplifier.

Note: In the higher access levels, the control pro-
gram provides a menu item for selecting the oper-
ating mode “Stereo” or “Bridge Mono” (Hardware
» Configure »Output Mode #Outputs 2 and 3
» ...). However, contrary to the setting described
above, it will not be possible for the user to recog-
nise the bridged mode selected via this menu on
the amplifier or in the views of the control program.
Therefore, never change the option “Stereo” via
this menu item; always set the bridged mode
according to the steps described above.

All rights reserved by MONACOR® INTERNATIONAL GmbH & Co. KG. No part of this instruction manual may be

10 Control via a
Tablet Computer

In addition to the supplied control program
for PCs, a control program named “DSP-
CONTROL” for tablet computers is avail-
able in the “App Store” of Apple Inc.

11 Specifications
RMS output power

at4Q: ... 2 x 500 W
at8Q: ... 2 x280W
bridged operation at 8 Q: . 1000 W
Peak output power: ...... 1200 W
Frequency range: ....... 20-20000Hz
THD: ... . ... .. .... <0.05%
Channel separation
for rated power at 8 Q: ....>100dB
S/Nratio: .............. > 119dB (A weighted)
Rated input voltage: . . . . .. 1.2V
Max. input voltage: . . ... .. 11V
Input impedance: ........ 24kQ
Line output: ............ 3.5V/1 kQ, balanced
Power supply: .......... 230 V~/50Hz
Power consumption: ... .. 1160 VA max.
Ambient temperature: ....0-40°C
Dimensions: ............ 482 x 89 x 335 mm, 2RS
Weight: . ............... 5.85kg

Subject to technical modification.

reproduced in any form or by any means for any commercial use.
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